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SCReWBase Version 9.0 Users' Guide 
Last updated August 1, 2012 

 
I. Introduction 
Well over a decade ago, four corkscrew enthusiasts got together over some beverages at 
the 1998 Napa Valley CCCC (Canadian Corkscrew Collectors Club) Annual Meeting and 
discussed the ideas put forth by Fred Kincaid on designing and building a corkscrew 
reference database/catalogue.  Fred convinced Frank Ellis, Fred O'Leary and Joe Paradi to 
join him in spending countless hours in designing a system that would accommodate the 
needs of the corkscrew collecting world.  The fruits of all these years of work by some of 
the most knowledgeable corkscrew collectors in the world (many others joined in as time 
went by) are presented here. 

The first software was built by Ms. Kathleen Cinelli and all versions of SCReWBase 5.5 and 
earlier was her work.  The new version, SCReWBase 6.0, released in September 2008 
obsoleted everything but the SCreWCode design as the software is a complete rebuild.  
This new release of the software is named SB9 and reflects the changes and improvements 
we had built in since the SB8 release last year. 

This edition of SCReWBase 9 has a new Class for British Brass Figurals, Class "Q" and has 
more pictures, descriptions, expert notes, references and much more.  The database is 
searchable and is based on a classification system that encompasses all classes, types and 
styles.  The new program also includes the ideas developed since and excludes the 
problems of the old – this new software was designed and built by Joseph Paradi (Joe 
Paradi's son). 

II. Organisation 
The SCReWCode is built from 3 alphabetic and 3 numeric characters (e.g. ABc123): 
The first capital letter is the Class designator and there are 13 classes in SCReWBase: 

Code Class Contents 
A Accessories Collectibles and “go-withs” which are not actually 

corkscrews but which we all seem to acquire 
B Bar screws Mechanical corkscrews that are designed to be fixed to a 

wall or a bar 
C Combinations Corkscrews with a tool or having one or more secondary 

functions 
E Easers Corkscrews designed to ease the adhesion of the cork to 

the bottle before pulling it out with a direct pull 
F Figurals Corkscrews in which the whole item, or a significant part 

of it, represents the figure of a tangible object 
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K Knives Knives (folding or fixed blade) with a folding corkscrew  
L Levers Corkscrews that have a mechanical action through the 

use of a simple or compound lever and fulcrum(s) 
M Mechanical Corkscrews which have a mechanical feature using a 

thread, ratchet, rack and pinion and others action 
N Non-worm extractor Cork removers that do not have helical worms 
P Pocket and Protected Corkscrews in which the worm is covered or otherwise 

protected for safety or travel 
Q British Brass Figurals 

(Flatbacks) 
Corkscrews made for the British souvenir markets of the 
early 20th Century 

S Self pullers and 
partial pullers 

Corkscrews based on the principle that continuous 
turning of the worm draws the cork up the helix 

T T-screws and other 
straight pulls 

Corkscrew with no mechanical features and no other 
tools 

Z Champagne and 
soda tools 

Tools for opening or tapping sparkling drinks bottles, 
wire cutter knives and other items 

 
Of the above list, there are three "odd" Classes, A, B and Z as these are not similar to 
anything else in the other 10 Classes.  But, they belong in SCReWBase, nevertheless. 
 
The second capital letter stands for the Type of a corkscrew under the Class signified by 
the first letter.  There are many such types, of course, and many are specific to the Class 
while others may be present in most, if not all, Classes. 
 
The third letter is the style which is specific to the Class/Type under which it is – and there 
are even more of these across SCReWBase. For more information, see the SCReW 
Companion document under the "Help" tab at the top line of the SCReWBase page.  
 
The 3 numerics are just serial numbers for the C/T/s codes – some has sub groupings 
(ranges of the serial numbers are assigned to some feature/function of the C/T/s). 
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III. Page layout – what is available 
 
Here is what a typical page looks like: 
 

 
 
This corkscrew data base is very user friendly and extremely easy to use.  The following 
pages will explain what each of the functions is (the purpose) and how to use it. 
 
We will take the page section by section as follows: 
 
1. Menu line: 
 

 
 
The File tab allows: 
Print – allows you to print a one page report of the record showing with all details 
Exit – allows you to close the program 
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The Tools tab allows: 
Options – where you can specify if you want a full page display or not when the page opens.  
In the picture below, this is done. 
 

 
 

 
 
The Help tab allows: 
 

 
 
Screw Companion – brings up the document in a PDF format – you can also print this. 
Users Guide - displays this document in a PDF format and it is printable. 
Go to the Website – Brings up the www.corkscrewsoftware.com  website where news and 
updates may be available.  It is wise to check once in a while as there may be useful 
information there – especially FAQs which are updated as we get new questions on how to 
do something. 
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About displays the version of the software you are running here. 

 
                        
This Version number is an important piece of information because if you report any 
problems with the software, we will need this data to establish what the solution may be. 
 
2. Command Line: 
 
  
   A            B          C  D  E         F       G  H      I            J   K 
The fields are marked with letters and here is what they do: 
A – This button |< allows you to skip one class backwards in the database – "C" below goes 
forward 
B – The field that allows you to go forward (right arrow) or backwards (left arrow) in the 
record list that you might want to see, also they show how many records are in the 
database – 2095 in this case. 
C – This button >| allows you to skip one class forward in the database – "A" above goes 
backwards 
D – The "binocular" or position button moves the record pointer (highlighted record) to 
wherever you want in the database – the start of the C Class here.  But there is another way 
to get this done too – just enter a class Letter or a code completely and then while holding 
the shift key, press the Enter key – works like a charm! 
E – This is the search toggle button.  You can either search the database or use the filters 
explained below.  When you are in search mode, this button is green (as shown).  When 
you are in filter mode, this button has a grey background and the filter button (H) that 
looks like a funnel, is green.   To return to 
search mode you click on this button. 
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F – Here is the search field (the magnifying glass must be green for this to work) – type in 
what you are looking for – e.g. Perille and then hit Enter to search.  All records will be 
found in which the word or characters exist that are displayed in the F box.  Hint: search 
for more than one character as a single letter is in every record in the database and the 
software won't let you do it anyway. 
G – This button will cancel the results of a Search and show the entire database again. 
H – The filter toggle button (a funnel) is similar to the search toggle button.  If it is green 
then you are in filter mode and if not you can click on it to switch to filter mode. The filter 
mode enables you to filter the database by Class/Type/style – e.g. select all Z Class only.  
Hint: using this, you can get a count of the records in the database for a class. 
I – The Class selector box, click on the pull down menu and select with the mouse cursor 
J – The Type selector box, click on the pull down menu and select with the mouse cursor 
K – The Style selector box, click on the pull down menu and select with the mouse cursor 
 
3. Record List Column 
This part of the front page shows the list of records at this part of the database – that is 
wherever you positioned it before.  The following information is available: 
Code – shows the SCReWCode of the record. 
Description – is a brief one liner of what the record is. 
 

 
Hint: you can scroll down using the slider or better, the down arrow to get to the next line. 

 
Hint: you can see the whole 
description if you move the 
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horizontal slider at the bottom of the column or highlight the record and then read the 
whole line in the "Description" box. 
 
4. SCReWCode data 
 

 
 
This is self evident, the SCReWCode, Class letter and name, Type letter and name, and Style 
letter and name. 
 
The second line is the "Description" field, typically a structured one line description of the 
corkscrew. 
 
5. Comments 

 
Simply, the details as they are available – sometimes a lot and sometimes little, but it is 
what there is in the record – if you have more, e-mail us at (fred@fredcork.com). 
 
6. Details 
More details about the piece: 
- Country of Origin 
- Manufacturer 
- Mfr. Date – This is the approximate date counted in ½ Centuries when it was made 
- Previous Ref. Number – this might be useful if the piece was moved from one SCReWCode 
to another – you can trace its past. 
- Last Update – this is when the record was updated by the ClassMaster 
- Picture File – the name of the picture file and where it is on your computer's disk 
- Patents / Registrations – Patent and other similar information when known to the 
ClassMaster. 
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Again, if you know anything else or see anything wrong, let us know by e-mail at 
(support@corkscrewsoftware.com). 
 
7. The Picture 
 

The picture is a representative one and yours may 
be a little different (handle, colour, etc.).  Hint: - if 
you left-click on the picture, you will get a usually 
larger picture with details more clearly shown – 
this is limited by the details supplied by the 
photographer who took the picture. 
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8. Reference Material 
 

 
 
Here we have references to publications on corkscrews, complete with the book or 
document title, author, publisher, the page number(s) and the year of publication. 
 
IV. Finding things 
 
There are several options here for you: 
 

  
Position - If you know the Class or even the Type of a corkscrew you want to identify, just 
type as many letters and numbers in the search box as you have (shown as letters MIf  in 
the command box above) and then click the binocular (or type Shift-Enter) and the pointer 
(highlighted in the Record List Column) will be placed at the first record in that Class/Type, 
or exactly on the record of you used the whole 6 character SCReWCode as your position 
pointer. 

Search - In the search box you can enter a name such as "Perille" or a word such as 
"France" or "Syroco" (no quote marks are required) followed by the "Enter Key".  The list of 
items which contain the character string you typed in will appear in the Record List Column 
on the left side of the screen.  Please note that the software searches the entire database, 
all appropriate fields and shows the entire results set. 

An Example below here we searched for the word "Perille" and found 105 records that 
contained the word. 

Hint: - it is best to select your search criteria as close as possible to what you want so that 
you don't have too many records to look at before you find just the one you wanted. 

Once the search is complete you can just scroll down the list until you see what you want.  
If the corkscrew is not in SCReWBase already, please send the picture and whatever 
description you would have for the various fields (especially markings) to us at 
(support@corkscrewsoftware.com) so we can get the Class Masters know and enter them 
into SCReWBase. 
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V. Conclusions 
 
Thanks to Class Masters: Jens Arnbjerg, Reinhold Berndt, Bjørne Berger, Fred Kincaid, 
Anne-Lise Køhler, Paul Luchsinger, Ray Moran, Joe Paradi, Roy Payne, Hans Türler, Wayne 
Meadows and program designer Joseph A. Paradi, we have a terrific program and the 
opportunity to expand it to as many different corkscrews as all you might find – there are 
new finds all the time!  For some of the Frequently Asked Questions ("FAQ") see the 
Appendix.  
 
To buy, go to:  http://www.corkscrewsoftware.com/ and follow instructions.  
 
Joe Paradi – August 2012. 
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Appendix 
 
Frequently Asked Questions 
 
1. I just got a new corkscrew, now how do I find it in SCReWBase? 
 

Follow these steps for an example – this picture of a corkscrew: 
 
- from the picture (or the real thing in your hand) you decide that 
after consulting the table at the beginning of this Users' Guide that 
this is most likely a class "M" for Mechanicals. 
- OK, now you type an M or m into the Search Box and click on the 
Binocular (or type Shift-Enter) to position the database to the start of 
Class M. 
- Here you see the record with the Code M00000 (this is the master 
or Zero record) that shows a number of corkscrews and shows their 
Type letters as well 
- But, you don't see your piece 

- So you move down to the next record which is M00001 and is the continuation of the 
Zero record.   
- Here you see another bunch of corkscrew pictures and there is an example that looks 
very much like yours and has a Class/Type code: MS 
- Now you type in ms (upper or lower case does not matter) into the Search box and click 
on the binocular again (or the "Enter" key while holding down the CTRL key) 
- Here you see some more examples, but you decide just to scroll down the records (using 
the down arrow) and soon you come to MSf051 which is exactly what you have in your 
hand. 
- Note that on the way down, you saw some other corkscrews and you might just note the 
three letter Code MSf and you should scroll through all if you are not absolutely sure that 
you have the exact record of your piece. 
- Job done! 
 
2. What if I can not find my piece in SCReWBase? – This will happen from time-to-time 
because not all corkscrews in the World are in SCReWBase.  So then after you enter the 
record into the Corkscrew Collector (CC) program you received the software "Bundle" you 
purchased as a "900" code or if you don't use CC then just e-mail the description and 
anything else you know about the piece together with a good picture to: 
(support@corkscrewsoftware.com).  The appropriate Classmaster will then enter it into the 
next release of SCReWBase. 
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3. How do I send new pieces to the SCReWBase administrators? – As shown in FAQ#2, just 
e-mail the description and anything else you know about the piece together with a good 
picture to: (support@corkscrewsoftware.com).  The appropriate Classmaster will then enter 
it into the next release of SCReWBase. 
 
4. How do I report errors or make additions to a SCReWBase record? – Again, just e-mail 
the SCReWCode of the piece and whatever the issue is to: 
(support@corkscrewsoftware.com) and we will take care of it.  You can not make any 
changes yourself. 
 
5. If I buy SCReWBase first how much will it cost to get Corkscrew Collector later? – If you 
have just purchased the software, you will have received both SB and CC on the same CD 
and would have installed it at the time you installed SB as the installer will do this 
automatically for you. 
 
If you did not buy the "bundle" (both programs at the same time), before this release (as 
you bought only SCReWBase 6.0) then when you upgrade to SB8 or later, you will receive 
both SB and CC in the same package.  Please note that SCReWBase must be installed first 
because CC will not work without it (there really is no way for you to not install SB since it 
is automatic)!  The lesson here is that if you uninstall (remove) SB, your CC will not work. 
 
6. How often will SCReWBase be updated? – The plan is to have new versions available 
about once a year. 
 
7. How will I get new releases? You will be able to order the new releases from the website: 
http://www.corkscrewsoftware.com/ for an upgrade fee.  Maintenance releases will be free 
and can be downloaded from the website.  Just check once in a while through the "help" 
tab as described above. 
 
8. What will be the cost for future new releases of the software? – There will be a set fee for 
the new release and you will get the complete Bundle – SB is not offered on its own.  
 
9. Can I email a SCReWBase record to a friend?  Yes.  From the pull down menu "file" 
choose Print.  When the report appears, there is a small copy icon (blue diskette picture) 
and this gives you two choices: 
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Choose Acrobat (PDF) file and when asked where to save it, name the file where you can 
find it.  Then, simply "Attach" this page to an ordinary e-mail to your friend.  But if you 
want to capture in information for your own use, choose Excel and then you can 
manipulate it before you print it. 
 


